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Introduction 

Many research centers and University Campuses require using advanced level of Network 

functionality, management, design and structure. There are many factors that need to be 

considered in organization of Network Management. 

In my project I have mentioned about the Network management structures that fit into many 

related fields of Network management and consoles. The most important structure will be 

applied to NEU campus. Regarding the policy and management of network strategies it allows 

the use of security, flexibility, and control o,f all conditions based on the development of many 

application programs that is supported under Win 2000 platform. 

Modem applications in today's Computer Networks include the use of multimedia applications 

such as Java and Oracle. The extensive use of Java makes it possible to bring various 

applications into progress to facilitate application development and structured programming. 

Java technology not only applies with modem Computer Network standards but also to 

applications regarding security systems such as banking with management with Oracle system. 

Oracle on the other hand brings secure, reliable, and advanced database management system to 

be used interactively with Java for use with industrial projects. 



Ill 

Table of Contents 
Page 

Acknowledgement i 

Introduction ii 

Chapter I: Introduction to Networking 

1.1 Microsoft 2000 Family 2 

1.1.1 Manageability 2 

1.1.2 Compatibility 2 

1.2 File And Folder Structure 3 

1.2.1 File Saving 4 

1.2.2 Recycle Bin Characteristics 4 

1.2.3 Shared Folder Characteristics 5 

1.3 Networking Fundamentals 5 

1.3.1 Dial Up Connection 6 

1.3.1.1 Making Dial Up Connection Using an ISDN Line 6 

1.3.2 Local Area Connection 7 

1.3.3 Virtual Private Network Connection Establishment 7 

1.3.4 Direct Network Connection Establishment 8 

1.3.5 Incoming Network Connection 10 

1.3.5.1 Connection Configuration 11 

1.3.5.2 Network Component Addition 11 

1.3.5.3 TCP/IP Installation 12 

1.3.6 13 
1.3.6.1 13 

1.3.7 Permanent Virtual Connection Using ATM 17 

1.3.8 SNMP Service Management 17 

1.3.9 IPSec Policy 15 

1.4 DNS 16 

1.4.1 DNS Domain names 17 

1.4.2 Understanding the DNS Domain Namespace 18 

1.4.3 DNS Query 19 



IV 

1.4.3.1 The Local Resolver: Part I 20 
1.4.3.2 Querying A DNS Server: Part II 21 

1.4.4 Query Responses 23 
1.4.4.1 Iteration Mechanism 25 
1.4.4.2 Caching 26 
1.4.4.3 Reverse Lookup 27 

1.5 Reverse Query 28 
1.6 Inverse Queries 29 
1. 7 Windows Clustering 30 

Chapter II: Windows NT Networking 

2.1 Active Directory Mechanism 

2.1.1 Introduction 

2.1.1.1 Directory Services 

2.2 Domains Overview 

2.2.1 Domain Trees and Forests 

2.2.1.1 Domain Trees 

2.2.1.2 Forests 

2.2.2 Domain Trusts 

2.2.3 Organizational Units 

2.2.4 Services and Directory Sites 

2.2.5 Groups 

2.2.6 Active Directory Schema 

2.3 Active Directory Object Names 

2.4 Active Directory Clients 

2.4.1 Locating Domain Name Controller 

2.5 Directory Data Store 

2.6 Server Role Management 

2.6.1 Domain Controllers 

2.6.2 Member Servers 

2.6.3 Stand Alone Servers 

31 

31 

31 

32 

33 

33 

34 

35 

36 

37 

39 

49 

41 

43 

43 

44 

45 

45 

46 

47 



2. 7 Benefits of Active Directory Information 47 

2.7.1 Policy Based Administration 47 

2. 7 .2 Extensive Functionality 48 

2.7.3 Scalability 48 

2.7.4 Information Replication 49 

2.7.5 DNS Integration 50 

2. 7 .6 Flexible Query 51 

2. 7. 7 Domain Management 51 

2.7.7.1 Domain Controllers and Forests 52 

2.7.7.2 Domain Naming 53 

2. 7. 7 .3 Trust Relationships 54 

2.7.8 Domain and Account Naming 54 

2.7.8.1 User Accounts and Management 55 

2.7.8.2 Computer Accounts 56 

2.8 Domain Trusts 57 

2.8.1 Trust Paths 57 

2.8.1.1 One Way Trust 58 

2.8.1.2 Two Way Trust 59 

2.8.2 Transitive Trust 59 

2.8.3 Non transitive Trust 60 

2.8.4 Trust Protocols 65 

2.8.5 Explicit Domain Trusts 65 

2.8.5.1 External Trust 62 

2.8.5.2 Shortcut Trusts 63 

2.8.5.3 Creating Explicit Trusts 64 

2.9 Site and Domain Relation 64 

2.9.1 Site Management 65 

2.10 Active Directory and User Account Management 67 

2.10.1 Account Management 68 

2.10.2 User Account Options 69 

2.10.3 Computer Accounts 70 



VI 

2.11 Group Policy, Management 71 
2.12 DNS Integration 71 

2.12.1 DNS Server and Active Directory Requirements 72 

2.12.2 DNS and Active Directory Installation 73 

2.13 Group Types 74 

2.13.1 Group Scopes 74 

2.13.1.1 Changing Group Scopes 75 

2.13.2 Built-in Groups 76 

2.13.3 Predefined Groups 76 

2.13.4 Groups and Windows 2000 Stand Alone Servers 78 

2.13.5 Nested Groups 78 

2.13.6 Performance Measures 79 

2.13.7 Universal Group Replication 80 

2.14 Network Bandwidth 80 

2.15 Directory Access Protocol 81 

2.15.1 LDAP and Interoperability 81 

2.16 Single Master Operations 82 

2.16.1 Forest Wide Operations Master Roles 82 

2.16.1.1 Schema Master 82 

2.16.1.2 Domain Naming Master 82 

2.16.1.3 Domain Operations Master Roles 83 
2.16.2 Relative ID Master 83 

2.16.3 PDC Emulator 83 

2.16.4 Infrastructure Master 84 

2.17 Administering Active Directory 84 

2.17.1 Delegating Administration 85 

2.17.1.1 Customizing MMC Consoles for Specific Groups 86 

2.17.2 Operations on Master Failures 87 

2.17.2.1 Schema Master Failure 88 

2.17.2.2 Domain Naming Master Failure 88 

2.17.2.3 Relative ID Master Failure 88 



Vil 

2.17.2.4 PDC Emulator Failure 

2.17.2.5 Infrastructure Master Failure 

2.17.3 Service Duplication 

2.17.3.1 Service Categories 
2.17.3.2 Service Information Characteristics 

2.17.4 Managing Security 

2.17.5 Programming Interfaces 
2.17.6 Active Directory Administrative Tools 

Chapter III: Networking NEU Campus 
3.1 Engineering Faculty 

3.2 Network Enrollment 

Conclusion 

References 

89 

89 

90 

90 

90 

91 

91 

92 

94 

95 

96 

97 



Vlll 

X 

List of Figures 

Figurel.4.2:DNS Domain Namespace 

Figurel.4.3.1:DNS Query Process 

Figurel.5:Revers Query 

Figure 2.2.1.1:Domain Tree 

Figure2.2.1.2:Forest 

Figure2.2.2a:Domain Trust 

Figure2.2.2b:Trust Relations on Domain Tree 

Figure2.2.3: Organizational Units 

Figure2. 7. 7.la:Domain Tree 

Figure2. 7. 7 .1 b:Forest 

Figure2.8.1:Trut Paths 

Figure2.8.2: Transitive Trust Relationship 

Figure2.8.5.1 :External Trust relayionship 

Figure2.8.5.2:Shortcut Trust Relationship 

Figure2.9a:Site And Domain Relation 

Figure2.9b:Site And Domain Relation 

Figure2.9.1:Site Management 

Page 

18 

20 

28 

33 

34 

35 

36 

37 

52 

53 

58 

60 

62 

63 

64 

65 

66 



Chapter I: Introduction to Networking 
1.1 Microsoft 2000 Family 
No matter where you are working, your computer will be easier to use and to manage, because 

Microsoft Windows 2000 Professional is more compatible and more powerful than any 

workstation you've used before. With Windows 2000 Professional, you have faster access to 

information, and you are able to accomplish tasks more quickly and easily. 

Windows 2000 Advanced Server includes all the new features of Windows 2000 Server, and in 

addition offers enhanced memory support, support for additional processors, and clustering. 

Enhanced memory and processor support means your server applications can faster, providing 

better response for users on the network. Windows 2000 Professional makes it easier to: 

1. Work with files. 

2. Find information. 

3. Personalize your computing environment. 

4. Work on the Web. 

5. Work remotely. 

1.1.1 Manageability 

You and your network administrators can work more efficiently now, because many of the most 

common computer-management tasks are automated and streamlined with Windows 2000 

Professional. With Windows 2000, your workstation will be easier to: 

1. Set up. 

2. Administer. 

3. Support. 

1.1.2 Compatibility 

Windows 2000 Professional offers increased compatibility with different types of networks and 

with a wide array of legacy hardware and software. Windows 2000 also provides: 

1. Improved driver support. 

2. Increased support for new-generation hardware and multimedia technologies. 

3. Integration of the new Euro currency symbol. 
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For all your computing needs, Windows 2000 Professional provides: 

I. Industrial-strength reliability. 

2. The highest level of security. 

3. Powerful performance. 

Windows 2000 Advanced Server includes all the new features of Windows 2000 Server, and in 

addition offers enhanced memory support, support for additional processors, and clustering. 

Enhanced memory and processor support means your server applications can faster, providing 

better response for users on the network. 

1.2 File and Folder Structure 

Almost all Windows 2000 tasks involve working with files and folders. The work you do with 

files and folders falls into three categories: 

1. You can perform basic file and folder tasks, such as creating, deleting, copying, and 

moving files and folders, and more advanced tasks, such as changing file and folder 

properties and managing shared folders. 

2. You can narrow the focus of your file and folder searches by including additional search 

criteria, such as the date, type, file size, or case sensitivity. You can also broaden the 

scope of your file searches by using wildcard characters, and specifying literal text or 

regular expressions. 

3. You can secure files and folders using Windows 2000 Professional security features, such 

as user and group accounts, Group Policy, shared folder and printer permissions, 

auditing, and user rights. If you have an NTFS drive installed, you can set file and folder 

permissions and encrypt files and folders. 

To open My Computer, double-click its icon on the desktop. To open a file or folder by using 

Windows Explorer, click Start, point to Programs, point to Accessories, click Windows 

Explorer, and then double-click the file or folder you want to open. 
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If the file you want to open is not associated with a particular program, you can select the 

program used to open the file by right-clicking the file, clicking Open With, and then selecting 

the name of the program. 

You can use commands on the View menu to change the way files are displayed. You can also 

use the View tab in the Folder Options dialog box to change file and folder settings. 

1.2.1 File Saving 

1. On the File menu of the program you are working in, click Save. 

2. If you haven't saved your file before, type a name for the file in File name. 

To save a copy of a file under a different name or in a different location, on the File menu, click 

Save As, and then specify a file name and location where you want to save the file. 

1.2.2 Recycle Bin Characteristics 

1. On the desktop, double-click Recycle Bin. 

2. Do one of the following: 

• To restore an item, right-click it, and then click Restore. 

• To restore all of the items, on the Edit menu, click Select All, and then on the 

File menu, click Restore. 

• To delete an item, right-click it, and then click Delete. 

• To delete all of the items, on the File menu, click Empty Recycle Bin. 

Deleting an item from the Recycle Bin permanently removes it from your computer. Items 

deleted from the Recycle Bin cannot be restored. You can also delete items by dragging them 

into the Recycle Bin. If you press SHIFT while dragging, the item is deleted from your computer 

without being stored in the Recycle Bin. 

Restoring an item in the Recycle Bin returns that item to its original location. To retrieve several 

items at once, hold down CTRL, and then click each item that you want to retrieve. When you 

have finished selecting the items that you want to retrieve, on the File menu, click Restore. 



If you restore a file that was originally located in a deleted folder, the folder is recreated in its 

original location, and then the file is restored in that folder. The following items are not stored in 

the Recycle Bin and cannot be restored: 

1. Items deleted from network locations. 

2. Items deleted from removable media (such as 3.5-inch disks). 

3. Items that is larger than the storage capacity of the Recycle Bin. 

1.2.3 Shared Folder Characteristics 

1. On the desktop, double-click My Network Places. 

2. Locate and double-click the computer in which the shared folder is located. 

3. Double-click the shared folder you want to open. 

1.3 Networking Fundamentals 

Networking lets you connect your computer to other computers or a private network. When you 

connect your computer to a network or another computer. 

1. Gain access to files and folders on other computers. 

2. Let other people gain access to your files and folders. 

3. Use printers and other devices that are connected to other computers. 

4. Let other people gain access to any printers or devices that are connected to your 

computer. 

There are many different ways to connect your computer to another computer or a network. 

Using Windows 2000, you can connect your computer to: 

1. Another computer using a direct cable connection. 

2. A private network using a modem or an Integrated Services Digital Network (ISDN) 

adapter or a network adapter card. 

3. A network using a virtual private network (VPN) connection. 

4. Another computer by having another computer calls your computer. 
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You can make these connections and configure networking protocols and settings using Network 

and Dial-up Connections, which can be found in the Control Panel. You can also connect to 

bulletin board services, networks, and other computers using the Telnet or HyperTerminal 

utilities. 

1.3.1 Dial up Connection 

Open Network and Dial-up Connections. 

1. Double-click Make New Connection, and then click next. 

2. Click Dial-up to private network, click next, and then follow the instructions in the 

Network Connection wizard. 

To open Network and Dial-up Connections, click Start, point to Settings, and then click 

Network and Dial-up Connections. When you connect to a remote access server, you can 

access data files across the telephone line; you cannot run programs remotely. For most 

applications, running a program across a telephone wire is unacceptably slow. For the best 

performance, you should install licensed copies of the applications you need on your local 

computer. 

1.3.1.1 Making Dial Up Connection Using an ISDN Line 

1. Open Network and Dial-up Connections. 

2. Double-click Make New Connection, and then click next. 

3. Click Dial-up to private network, click next, and then follow the instructions in the 

Network Connection wizard. 

To open Network and Dial-up Connections, click Start, point to Settings, and then click 

Network and Dial-up Connections. 
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1.3.2 Local Area Connection 

Typically, most Windows 2000 users belong to a local area network. When you start your 

computer, Windows 2000 detects your network adapter and automatically starts the local area 

connection. Unlike other types of connections, the local area connection is created automatically, 

and you do not have to click the local area connection in order to start it. 

Windows 2000 automatically creates a local area connection for each network adapter that it 

detects. If more than one network adapter is installed, you can eliminate possible confusion by 

immediately renaming each local area connection to reflect the network that it connects to. 

If your computer has one network adapter, but you need to connect to multiple LANs (for 

example, when traveling to a regional office), the network components for your local area 

connection need to be enabled or disabled each time you connect to a different LAN. 

1.3.3 Virtual Private Network Connection Establishment 

1. Open Lletwork and Dial-up Connections. 

2. Double-click Make New Connection, and then click next. 

3. Click Connect to a private network through the Internet, and click next. 

4. If you have already established a dial-up connection, do one of the following: 

• If you need to establish a connection with your ISP or some other network 

before tunneling to your destination computer or network, click automatically 

dials this initial connection, click a connection in the list, and then click 

next. 

• If you do not want to automatically dial an initial connection, click do not 

dial the initial connection, and then click next. 

If more than one network adapter is installed, you need to add or enable the network clients, 

services, and protocols that are required for each local area connection. When you do so, the 

client, service, or protocol is added or enabled for all other network and dial-up connections. 
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5. Type the host name or IP address of the computer or network to which you are 

connecting, and then click Next. 

6. Do one of the following: 

• If you want this connection to be made available to all users on your network, 

click for all users, and then click next. 

• If you want to reserve the connection for your own use, click only for myself, 

and then click next. 

7. If you want to let other computers access resources through this dial-up connection, select 

the Enable Internet connection sharing for this connection check box, and then click 

next. 

8. Type a name for the connection, and then click Finish. 

To open Network and Dial-up Connections, click Start, point to Settings, and then click 

Network and Dial-up Connections. To make the connection available to all users, you must be 

logged on as Administrator or as a member of the Administrators group. 

You can create multiple VPN connections by copying them in the Network and Dial-up 

Connections folder. You can then rename the connections and modify connection settings. By 

doing so, you can easily create different connections to accommodate multiple hosts, security 

options, and so on. 

1.3.4 Direct Network Connection Establishment 

1. Open Qetwork and Dial-up Connections. 

2. Double-click Make New Connection, and then click next. 

3. Click Connect directly to another computer, click next, and then follow the 

instructions in the Network Connection wizard. 



To open Network and Dial-up Connections, click Start, point to Settings, and then click 

Network and Dial-up Connections. To create a direct network connection that acts as a host, 

you must be logged on as Administrator or be a member of the Administrators group. Guest 

direct network connections do not require administrator-level rights. 

If you specify your connection as a host when you create it, the connection appears as Incoming 

Connections in the Network and Dial-up Connections folder. You can create multiple direct 

connections by copying them in the Network and Dial-up Connections folder. You can then 

rename the connections and modify connection settings. By doing so, you can easily create 

different connections to accommodate multiple ports, host computers, and so on. 

Direct connections can bypass authentication requirements. This is useful for devices such as 

palmtop computers. You must configure this setting in the host incoming connection. For more 

information, see Related Topics. If you create a direct connection by using a serial (RS-232C) 

cable, the port that you select in the Network Connection wizard is enabled for connections that 

use a null modem. 

If you are logged on to your computer as Administrator or a member of the Administrators group 

when you create a direct connection, you are presented with a list of connection devices to 

choose from that includes all of the parallel ports for the computer, infrared ports that are 

installed and enabled, and COM ports. If you are logged on as a user who is not a member of the 

Administrators group, and create a direct connection, the list of devices includes the parallel 

ports for the computer, infrared ports that are installed and enabled, and only the COM ports that 

are configured with null modems. If you need to use a COM port for a direct connection, ask 

your system administrator to configure one of the COM ports on your computer with a null 

modem by using Phone and Modem Options in Control Panel. 

Users do not need to use direct connections to allow access to shared resources, such as files and 

printers, over a local area network. In order to enable shared access to resources on the local 

computer, you must enable file and print sharing, share the resources, and then set up the 

appropriate permissions. 
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1.3.5 Incoming Network Connection 

1. Open Qetwork and Dial-up Connections. 

2. Double-click Make New Connection, and then click next. 

3. Click Accept incoming connections, click next, and then follow the instructions in the 

Network Connection wizard. 

To open Network and Dial-up Connections, click Start, point to Settings, and then click 

Network and Dial-up Connections. If you make another incoming network connection, and 

you use the Network Connection wizard again, the existing incoming network connection is 

reconfigured. To create an incoming network connection, you must be a member of the 

Administrators group. 

For large numbers of incoming connections on a computer running Windows 2000 Server that 

operates as part of a distributed network or as a domain controller, use Windows 2000 Server 

Routing and Remote Access to create a remote access server. 

If your incoming connection and Fax Service have problems working together (for example, you 

cannot receive incoming connection calls on a device enabled for Fax receive), the modem may 

not support adaptive answer. Check your modem documentation to verify that you need to 

disable Fax receives for that device to accept incoming connections. 

If you connect to a computer running Windows 2000 Professional or stand-alone Windows 2000 

Server that is configured for incoming connections, and you are running Windows 95 or 

Windows 98 and want to log on to the computer by using a local user account, you can use your 

Windows 95 or Windows 98 user name, domain, and password. When you connect, the 

computer running Windows 2000 replaces the Windows 95 or Windows 98 domain name with 

the local computer name when you provide your user name and password authentication 

information. Incoming connections are only used for dial-up, VPN, or direct connection clients. 



1.3.5.2 Network Component Addition 

1. Open Qetwork and Dial-up Connections. 

2. Right-click the connection to which you want to add a network component, and then 

click Properties. 

3. Do one of the following: 

• If this is a local area connection, click Install. 

• If this is a dial-up, VPN, or incoming connection, on the Networking tab, 

click Install. 

4. In the Select Network Component Type dialog box, click Client, Service, or Protocol, 

and then click Add. 

5. Do one of the following: 

1.3.5.1 Connection Configuration 

1. Open Qetwork and Dial-up Connections. 

2. Right-click the connection you want to configure, and then click Properties. 

3. Do one or more of the following: 

• To configure dialing devices, phone numbers, host address, country/region 

codes, or dialing rules, click the General tab. 

• To configure dialing and redialing options, multilink configuration, or X.25 

parameters, click the Options tab. 

• To configure identity authentication, data encryption, or terminal window and 

scripting options, click the Security tab. 

• To configure the remote access server and protocols used for this connection, 

click the Networking tab. 

• To enable or disable Internet connection sharing and on-demand dialing, click 

the Sharing tab. 

To open Network and Dial-up Connections, click Start, point to Settings, and then click 

Network and Dial-up Connections. Depending on the type of connection you are configuring, 

different options appear. For example, a local area connection only displays the General tab. 
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